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Overview

The BIM-VSUM/PC Tools are a collection of Microsoft Windows based applications designed to provide
powerful analysis and file design capabilities for IBM Mainframe based VSAM files. The programs use a standard
VSAM IDCAMS utility LISTCAT produced on the host system as input. The applications extract and enhance the
standard VSAM Catalog information and store that data in one or more PC databases. The applications provide various
rapid query and reporting functions to greatly enhance the productivity of VSAM file analysis and maintenance. The
PC databases are created in Paradox database format so that the information can be easily read by spreadsheet,
reporting, and database packages, for customized analysis projects.

The BIM-VSUM/PC Toolset includes:

•  VSAM LISTCAT Extract : which reads the standard VSAM LISTCAT output files to produce the PC databases
utilized by the other tools.

•  VSAM Catalog Scan : allows the stored VSAM Catalog information to be quickly sorted by various key statistics,
like most CI Splits or most EXCPs, to locate the files that may require additional analysis. Any VSAM file may be
selected for detail analysis including modeling possible changes to the file's attributes. Graphic representation of
key information, such as VSAM Control Area and Control Interval, help you plan for optimizing VSAM
performance.

•  VSAM File Manager : provides a unique alternative method for viewing the stored VSAM file information,
modeled after the Windows File Manager. The VSAM qualifiers that make up the VSAM file name are treated like
multiple level directories. Like the Catalog Scan application, any VSAM file may be selected for detail analysis
including modeling possible changes to the file's attributes. The user may select one of the available search criteria
to filter the list of VSAM file names.

•  VSAM Space List : this application provides quick access to the VSAM managed DASD space associated with
VSE/VSAM Catalogs, including printing of standard space utilization reports.

•  VSAM Top File Reports: provides a quick way of obtaining standard reports from the stored VSAM file
information, which may be used as 'to do' lists for VSAM Administrators or systems programmers. The reports
create special subsets of the database that can be stored in other standard formats and utilized for custom analysis.

•  VSAM Top File Charts: allows the user to view standard charts or graphs from the stored VSAM file
information. The charts provide a unique perspective of the selected VSAM statistics. This application is designed
with the same user interface as the Top File Reports applications, but to create viewable charts rather than printed
reports.

•  VSAM Model Definition: provides a fast path to the VSAM modeling functions also available in the other
applications. This helps the user to make accurate estimates of new VSAM file requirements, prior to file
definition and loading.
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The BIM-VSUM/PC Tools provide a variety of methods for reviewing the inventory of VSAM files in one or
more VSAM Catalogs. There are several reasons why it is important to review the VSAM Catalog detail information.
The VSAM definition options for many files were selected a number of years ago. Changes in the Disk capacity and
performance characteristics as well as changes in the operating system software may require adjustment of the VSAM
file options to improve overall performance. Many VSAM files were defined using ‘standard’ definition options,
sometimes provided with vendor software and were never optimized for the unique requirements of an installation. The
BIM-VSUM/PC Tools were designed to help you locate the VSAM files that may benefit from changes to improve the
efficiency of an operational mainframe system. The tools can also be used to help plan the requirements for new or
expanded VSAM files. The BIM-VSUM/PC Tools are a set of Windows applications that can be installed in a few
minutes on any workstation that supports the 16-bit Windows 3.1 API, including Windows 95 and OS2 systems with
WINOS2. There are no mainframe programs to install or configure. The only requirement is that some file transfer
capability be available to move the IDCAMS LISTCAT output file to the workstation for processing.

The first step is to get the VSAM Catalog information to the Windows PC were the analysis will be
performed. The BIM-VSUM/PC Tools use the standard IDCAMS LISTCAT ALL as input. The LISTCAT output
from one or more VSAM Catalogs should be downloaded to the PC where the VSAM Tools were installed. The
downloaded LISTCAT files are the input to the VSAM LISTCAT Extract application. This program reads the VSAM
Catalog information and saves the detailed file information in Paradox formatted relational databases on the
workstation. These databases can be used directly by standard spreadsheets and database query tools. The BIM-
VSUM/PC Tools provide specialized functions for querying and viewing the VSAM Catalog information. The
information from many VSAM Catalogs can be stored in a single VSAM Object database to help provide a broad view
of an installation’s VSAM files. The best time to collect the LISTCAT data is after the batch or online processing
cycle, but before any daily reorganization jobs. This will provide the most useful statistical content for the VSAM files.
For VSAM LISTCAT Extract program can also produce a VSAM Space Database for VSE/VSAM users to help
review the VSAM defined DASD space utilization.

The VSAM Catalog Scan is a good first tool to begin analyzing an installation’s VSAM based file inventory.
The application uses a VSAM Object Database as input The program was designed to allow the user to view either a
single catalog or all VSAM catalogs in a spreadsheet like grid that could be scrolled to scan for possible problems or
opportunities for improvement. The lists can be quickly sorted by various key data elements, like number of VSAM
accesses, CI and CA split activity, and file size. If a VSAM file contains some interesting or unusual characteristic, you
can double-click on any data element to get a detailed view of that file. This detailed view allows the user to perform
‘what if’ changes to the VSAM file’s options and includes special graphical views of the VSAM Control Interval and
Control Area. There is also a VSAM Option Wizard that will step the user through a sequence of questions that will be
used to suggest a set of VSAM options. The primary usage of the Catalog Scan program is to browse the catalog
statistics in search of a new problem, but it can also be used to obtain a more complete view of a single file that has
some suspected problems.

The VSAM Top File Charts application is another way to take a quick look around for a mainframe system’s
most important VSAM files. The user can choose any of the ten standard selection criteria to view the files that are in
some respect outstanding; like most unused DASD space, most VSAM requests or most DASD extents. The top 10 to
50 files will be displayed using three-dimensional Bar Charts. The Chart view allows the user can choose to skip the
first files so that the files with extremely high statistics do not make the rest difficult to view. The graphical nature of
this application can provide a unique perspective when viewing some statistics. For example, when the number of CI
splits is charted with the total number of records added, it shows the user how often the splits occur in relation to
overall insert activity. Many mainframe systems have a few very large or highly active VSAM files that can have a
significant impact on the resource usage.

The VSAM Top File Reports application was designed for the VSAM administrator that likes to work from a
small printed ‘to do’ list. There are ten standard reports to choose from. The application generates special report
databases, containing the subset of files for that report. These reports can be printed, viewed, or exported into one of
the available spreadsheet or database formats for customized analysis. By limiting the size of the reports to the top 50
to 200 files based on a user selected criteria, like most I/Os, most CA splits, or most DASD extents, the program can
minimize the time required to get the latest lists of VSAM files that might require attention.
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The VSAM File Manager application was designed to give VSAM Administrators a unique new way to view
the VSAM Catalog statistics, similar to the familiar File Manager application for Microsoft Windows. In many systems
the VSAM file names contain high level qualifiers that are used to group files from applications together, for example
production payroll files might begin with PROD.PAYROLL. The VSAM Visual File Manager views the high level
qualifiers of the VSAM file names as a tree structure, with each qualifier appearing as a file folder which can be
expanded or collapsed to view the next level as well as the files sharing the common names. The tree structure can be
viewed either with the VSAM Catalog as the first folder or with all catalogs combined into a single list. This can help
to review all the VSAM files from one application even though the files may be spread across multiple VSAM
Catalogs for improved performance. The list of VSAM files with the currently selected high level qualifier is displayed
in a scrollable window. Detailed file information, including Model Definition, can be viewed simply by double clicking
on a particular file name. A powerful File Search capability allows the selection of one of a number of search criteria to
filter the number of VSAM files displayed. Some of the predefined filters involve combinations of catalog data. For
example you can select files with more Index I/Os than Data component I/Os, or files with free space defined that have
not had any new records added.

The VSAM Space List application was designed to help VSE/VSAM users to manage the DASD space
owned by the various VSAM Catalogs. The application provides a spreadsheet style to view the VSAM Space related
data. Two windows are used to display the Catalog information, one lists the VSAM Spaces for each Catalog, while a
second window shows the VSAM files which have extents in the currently selected VSAM Space. This application also
produces two standard printed reports, which can be summarized either by DASD volume or by VSAM Catalog. The
VSAM administrator or systems programmer can use this application to periodically review the predefined VSAM
spaces to avoid running out of space when expanding current VSAM files which could cause an unplanned outage for a
critical online system. A Chart option is available to visually locate the volumes with the most available space for
adding new VSAM files as well as seeing which VSAM volumes are nearing their currently defined capacity limits.

The VSAM Model Definition application is simply a fast path to the Model Definition capabilities already
available in the other applications. This allows for quick, accurate planning for new VSAM based files. This modeling
includes DASD space estimates for various device types and allows the user to see all the detailed load/reorganization
statistics that might affect performance and efficient DASD usage. It is rather common for VSAM KSDS files with
longer key lengths to fill up the Index record before all the Data Control Intervals in a Control Area are filled, which
leaves unusable data areas and expands the overall size of the VSAM file. The model definition application estimates
of how much of each Index Control Interval will be utilized based on key length and other factors to help avoid VSAM
files with unusable Control Area space. There are graphical views of the VSAM Control Interval and Control Area, that
can be used to understand the current or planned allocation of free space to better match the needs of the applications.
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Software Installation Information

The BIM-VSUM/PC Tools, a set of Microsoft Windows based applications, were designed to provide powerful, 'state
of the art', VSAM file analysis and design functions for the professionals that create and maintain IBM mainframe
VSAM databases.

To begin installing the BIM-VSUM/PC Tools software, insert the CD and follow the on screen instructions. If the
Autorun feature is not active on your CD, then run the program x:\SETUP program found on the CD. (‘x’ is the CD
drive letter.)
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Hardware Requirements

Testing has been performed on Intel 486, and Pentium systems with a minimum of 8 Megabytes of RAM.
Tests have shown significant performance benefits from faster CPUs and additional RAM.

Software Requirements

1. The applications have been tested on the following platforms:

Windows 3.1
Win OS2 on OS/2 2.1 and OS/2 Warp
Windows 95 and 98
Windows NT

2. The BIM-VSUM/PC Tools utilize the BORLAND Database Engine (IDAPI) to create Paradox formatted
databases from the VSAM LISTCAT files used as input. The necessary BORLAND software is included and will
be installed with the BIM-VSUM/PC Tools.

3. The BIM-VSUM/PC Tools include some standard printed reports that were developed using the Reportsmith
software. The Reportsmith Runtime code will be installed from the supplied installation media.

4. During the Reportsmith Runtime installation process a list of optional database drivers may be selected. The only
required database type for the BIM-VSUM/PC Tools is the Paradox Database driver.

Host Operating Systems Supported

The BIM-VSUM/PC Tools are designed to process VSAM LISTCAT output from either VSE/VSAM
Catalogs from VSE/ESA and VM/ESA systems and also LISTCATS from MVS/ESA or OS/390 ICF Catalogs. There
are not separate versions of the applications, based on operating system.
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The best way to get started using the BIM-VSUM/PC Tools software is to follow the step by step instructions
in this Tutorial section. This will introduce the primary functions and features and help you to learn the various user
interfaces used by the VSAM Tools.

VSAM LISTCAT Extract Tutorial

1. Select the VSAM LISTCAT Extract application.

2. Selecting the input file :
Click on the Checkbox next to ‘Current Listcat File’.
Locate and select the file VSESPUC.TXT, which is in the C:\BIMVSUM2\SAMPLES subdirectory.

3. Creating an output Database for VSAM file information:
Click on the Checkbox next to ‘VSAM Object Database’ .
Click on Yes to Create a new Table.
Type VSOBJTUT over the default database name VSOBJ001.
Click on OK to return.

4. Creating an output Database for VSAM Dasd Space information:
Click on the Checkbox next to ‘VSAM Space Database’ .
Click on Yes to Create a new Table.
The name VSSPCTUT will be the default database name.
Click on OK to return.

5. Begin Extracting the VSAM Catalog Information from the first input file.

Click on the Begin Processing button.

Wait for the Processing status to show ‘Processed’.
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6. Select the next input file for processing.
Click on the Checkbox next to ‘Current Listcat File’.
Locate and select the file USER01.TXT, which is in the C:\BIMVSUM2\SAMPLES subdirectory.
Click on OK to return.
Click on the Begin Processing button to begin extracting the next VSAM Catalog  data.

7. Repeat step 6 for two more input files: USER02.TXT and USER03.TXT.

(note multiple VSAM LISTCATs may be contained in a single input file)

8. Click on the Close button to exit.
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VSAM Visual Catalog Scan Tutorial

1. Select the VSAM Visual Catalog Scan application.

2. Selecting the input database :
Select the VSAM Object Database VSOBJTUT.DB
Click on OK to begin processing.

3. Scrolling the database grid.
Try scrolling to the right using the arrow keys or the Tab key.
Try scrolling up and down using the Page Down and Page Up keys.
The Home and End keys may be used to jump to the 1st or last data column.

(Note Columns may be resized within the grid area. Columns may also be dragged
to a new position to ease comparison of data elements.)

4. Sorting the VSAM files , ( finding the largest files )
Click on Highest Total_Alloc_RBA under Result Set Ordering Options.

5. Sorting by another criteria ( most Control Area, CA Splits )
Click on Most CA_Splits under Result Set Ordering Options.



BIM-VSUM/PC - First Time User’s Tutorial

18

6. Displaying the formatted Detail Catalog for one file.
Find the file VSE.CONTROL.FILE in the list of VSAM files.
Double-Click any column of data within the row for the file VSE.CONTROL.FILE. or click on the Detail menu
option.

The Cluster Page is displayed first.

Note the following:
That 100% of the records have been inserted since the file was created.
There have been 2,763 records inserted, with 174 CI Splits and 30 CA Splits.
Approximately 6 percent of the record insertions caused CI Splits.
About 1 percent of the inserts caused CA Splits.

You can also see that the file has 33 extents.
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7. Click on the Data tab to view information from the Data Component of the file.

8. Click on the Index Tab to view the Index Component detailed information.

9. Performing file design analysis.
Click on the Model Definition Tab to begin file design analysis.
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Change the allocation unit in the Data Component section from Track to Cylinder
Press the Re-Calculate button.

The warning  'Index CI Too Small, Increase Index or Data CI Size’ is displayed. Changing the allocation to
Cylinder caused a larger VSAM Control Area, which requires additional space in the Index record.
Change the CI Size in the Index Component to 2048 using the dropdown list.
Press the Re-Calculate button again.

Click on the Show CA Map button to display the various sections of the VSAM Control Area.
Click on Return.

To see the effects of adding free space:
Increase the CI FreeSpace % to 5
Increase the CA FreeSpace % to 10.

Click on the Re-Calculate button.

Scroll the window area titled Estimated Load / Reorg Results to view an extensive set of statistics relating to
loading or reorganizing the VSAM file using the current attributes.

For example using the adjusted options the 'AVG CA Load Percent' is 81%, meaning 81% of the VSAM Control
Area will contain user data records..
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10. Click on the Show CA Map button to display the projected layout of the VSAM Control Area.

Click on Return.

11. Click on the Show CI Map button to display the projected layout of the VSAM Control Interval.
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Click on Return.

12. Click on the Load Estimates tab to view all the same statistics related to Load/Reorg analysis.

13. Click on the Model Definition Tab.

Now Click on the Option Wizard Button to invoke the VSAM Option Wizard to get some advice on choosing the
VSAM file options.
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The first step is to check the VSAM Catalog Statistics to see how the current file is being used.

This file has two characteristics, “High Percentage of Read Access”, in this case over 99% of all VSAM requests for
this file are reads. The file also has more than 20% new records added since being loaded or reorganized last.

Click on the Next button.
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You may change the VSAM file type and key length information or accept the current values.
Click on the Next button to proceed.

Use the drop down list to change the Dasd device to a 3390.
Click on the Next button to proceed.
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You may change the average and maximum record sizes or accept the current values.
Click on the Next button to proceed.

Change the percentage growth planned to 20%.
Select the option ‘New Records are added in groups…’ and set the group size to 5.
Click on the Next button to proceed.
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Select the option ‘Applications will perform both random and sequential retrieval of records’ and set the number
of records retrieved in a typical Browse to ‘4’.
Click on the Next button to proceed.

Here you select the primary objective, Read performance Vs. Dasd Space Vs. Insert efficiency.
You may also select other VSAM options, like limiting CI sizes to match LSR Pool buffer sizes.
Click on the Next button to proceed.
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You can adjust the range, minimum and maximum Control Interval sizes to be considered.
Click on the Next button to proceed.

The VSAM options are selected based on the previous answers. You may scroll back to change your answers.
Click on the Accept button to return to the Model Definition and recalculate using the Wizard’s VSAM options.
The Cancel button will return with the original options unchanged.
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This is the result after recalculation with the VSAM Option Wizard selected values.

Data CI Size: 8,192
Index CI Size: 2,048
4 Percent CI Free Space
13 Percent CA Free Space

Click on Return to return to the file list.

14. Limiting the search to a single VSAM Catalog

Click on the Catalog VSAUSER.CAT.USER02 under Available Catalogs.
Now only files in the selected Catalog will be displayed.
Scroll down the Result Set Ordering Options and Click on Highest Total EXCPs to display the files with the
highest I/O activity first.
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The following result should be displayed:

15. To exit the program:

Click the Exit Menu option.
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VSAM File Manager Tutorial

1. Select the VSAM File Manager application.

2. Selecting the input database :
Select the VSAM Object Database VSOBJTUT.DB
Click on OK to begin processing.

3. Expand the content of a single VSAM Catalog from the list.
Double click on one catalog VSAUSER.CAT.USER02 to show the first level qualifiers for dataset names
contained in that catalog.

4. Expand one first level qualifier to display the VSAM files list.
Double click on the qualifier CSP to show all the files in the selected Catalog that have the first level qualifier of
'CSP'.

Note the status area at the bottom shows:

 9 files with a total size of 13.32 Megabytes and over 16 million VSAM access operations.
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5. Change the order of the VSAM file names
Click on the View menu option
Click on the Sort by Size suboption to reorder the list by dataset size.

6. Expand a second VSAM Catalog's contents.
Double click on the catalog VSESP.USER.CATALOG to show the first level on dataset names contained in that
catalog.

7. Expand the same first level qualifier in the VSESP.USER.CATALOG to display the VSAM files.
Double click on the qualifier CSP to show all the files in the selected Catalog that have the first level qualifier of
'CSP'.

Note the status area at the bottom shows 33 files with a total size of 81.65 Megabytes and over 22 million VSAM
access operations.

8. Scroll the list of VSAM file names using the scroll bar on the right.
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9. Switch to viewing all the VSAM files, regardless of Catalog, as a single list.
Click on the View menu option
Click on the File Name sub-option, on the left, to reorder the list to include all files regardless of the VSAM
Catalogs.

Now the list on the left contains all first level qualifiers from all the VSAM Catalogs contained in the VSAM
Object database.

10. Expand the same first level qualifier in the to display the all the VSAM files.
Double click on the qualifier CSP to show all the files in the selected Catalog that have the first level qualifier of
'CSP'.

Note the status area at the bottom shows 43 files with a total size of 121.57 Megabytes and over 113 million
VSAM access operations.

11. Scroll the list of VSAM file names using the scroll bar on the right.
Scroll the list of VSAM files to the right using the scroll bar at the bottom to show additional information about
each file, including the primary data volume, the date of creation and the VSAM catalog that contains the file.
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12. Display the detail information from one file
Double click on the file CSP.FZERSAM.ALF to begin viewing the file details.

13. View additional VSAM Detail or model changes to VSAM Options:

Click on the Data tab to view Data component information.

Click on the Index tab to view Index component details.

Click on the Model Information tab to begin modeling possible VSAM option modifications.

Click on the Show CA Map button to display a Control Area view.
Click on the Return button.

Click on the Show CI Map button to display a Control Interval graphic representation.
Click on the Return button.

Click on the Return button to exit the detail display.
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14. Select a search criteria to limit the number of VSAM files displayed
Click on the File menu option
Click on the Set Search Criteria sub-option.
Locate the text Index I/Os Exceed Data I/Os under Search Criteria and click on the text. This will limit the list of
VSAM files to contain only files with more I/Os for Index Component records than Data Component CIs.
Click on the Return button to return and begin the file search.

Note: this list contains a number of useful search options that can be used to locate VSAM files with options or
statistics that might indicate that the VSAM options should be reviewed.

VSAM Visual File Manager
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15. Double click on the qualifier CSP to show the files that met the search criteria

Note the status area at the bottom shows 4 files with a total size of 1.54 Megabytes and 299 VSAM access
operations. When the mouse pointer is over the left window, the current search criteria will be displayed in the
status area.

16. To exit the application Click on the Exit menu option.
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VSAM Space List Tutorial

1. Select the VSAM Space List application.

2. Selecting the input database :
Select the VSAM Space Database VSSPCTUT.DB.
Click on OK to begin processing.

3. Scrolling the database grid.
Try scrolling to the right using the arrow keys or the Tab key.
The Home and End keys may be used to jump to the first or last data column.

As you scroll the top window up and down to select a different Space Extent, the bottom window will
automatically show the VSAM files that are contained in currently selected VSAM Space.

4. Sorting the VSAM Space Extents, to find the largest VSAM Disk extents.
Click on Highest Total_Alloc under Result Set Ordering Options.

5. Sorting by another criteria, ordering by Volume labels.
Click on Space_Volume under Result Set Ordering Options.
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6. Request a Printed summary report.
Click on the File menu option
Click on the Print/View Reports menu sub-option.
Click on the By Volume menu sub-option to get a summary of each DASD Volume.

Click on the Preview button to preview the report before printing.
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Click on the File menu option
Click on Exit to return to the VSAM Space grid display.

7. Display a summary Chart.
Click on the File menu option
Click on the Chart Volumes menu sub-option.
Click on the DASD Tracks menu sub-option.
Double-click on the ‘unused’ (Blue) section of volume USER01 to show the number of unused tracks.

Click on the Return button to return to the main application view.

8. Exit the application.  Click on the Exit menu option
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VSAM Top File Reports Tutorial

1. Select the VSAM Top File Reports application.

2. Selecting the input database :
Select the File Menu option.
Select the Define Input menu sub-option.
Locate and select the VSAM Object Database VSOBJTUT.DB as the input for the reports.

3. Select the first report.
Click on the panel labeled Largest(Allocated) to request a report
Each Panel on this screen represents a different VSAM file report. The input Catalog database will be searched for
the VSAM files that match the particular criteria of the selected report. In this case it will be the VSAM files with
the largest High Allocated Relative Byte Address (RBA).
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Click on the Preview button to browse the report prior to printing.

Note the Borland Reportsmith software is used to support printing.

The report can be scrolled using the scroll bars.
See the help information for additional functions within Reportsmith.
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Use the File / Print Setup option to make sure the proper printer is selected.
Use the File Print option or the Printer Icon to Print the Report.
Use the File / Exit option to return to report selection.

4. Select the next report.
Click on the panel labeled Most CI Splits to request a report of the VSAM file with the largest number of Control
Interval Splits.
Click on the Preview button to browse the report prior to printing.

Click on the File menu option.
Click on the Save As sub-option to display the dialog used for saving the current report data in other formats. This
may be used to move the selected report information into a spreadsheet for custom analysis.
Click on Cancel.
Use the File / Print option or the Printer Icon to Print the Report.
Use the File / Exit option to return to report selection.
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5. Select a larger size for the next report. The default report size is 50 files.
Select the Options from the menu.
Select Top 100 files from the list of report sizes.

6. Select the last report.
Click on the panel labeled Most Dasd I/Os ( Excps ) to request a report of the VSAM file with the most physical
I/Os recorded in the Catalog statistics.

7. Print a report without previewing.
Click on the Print button to print the report without previewing the report.

8. Exit the application.
Click on the File menu option.
Click on the Exit menu sub-option.
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VSAM Top File Charts Tutorial

1. Select the VSAM Top File Charts application.

2. Selecting the input database :
Select the File Menu option.
Select the Define Input menu sub-option.
Locate and select the VSAM Object Database VSOBJTUT.DB as the input for the charting.

3. Select the first Chart for viewing.
Click on the panel labeled Most Allocated Space to request a chart of the VSAM files with the largest High
Allocated Relative Byte Address (RBA).

By default the top ten files are displayed in the chart.
The VSAM file names are listed in the legend to the right to the chart, with a number that matches the numbers
below the charted data bars.
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Each Chart shows two statistics from the VSAM Catalog. In this Chart, the Utilized Space (Red) can be compared
to the Unused Space (Blue), to help visually note which files may contain large amounts of unused space.

Note: in this chart, file number 4,  ATR.SYST.FILE21 has the most unused space.

Click on the Return button to return to chart selection.

4. Select the next Chart.

Click on the panel labeled Most Dasd Extents to request a chart of the VSAM files with the largest number of
Disk extents.

This Chart shows the Data Component extents in Red and the Index Component Extents in blue.

Click on the Return button to return to chart selection.



BIM-VSUM/PC - First Time User’s Tutorial

45

5. Select a larger list of files for the next chart. Note the default report size is 10 files.
Select the Options from the menu.
Select Top 20 files from the list of chart options.

Click on the panel labeled Most Dasd Extents to request the same type of chart with more files displayed.
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6. Display the Detail of a specific file.

Right click on the blue or red bar of the third file in the chart named “OASIS.SYST.FILE03” with the right
mouse button. This will create a tabbed notebook display of the file’s detailed information.

Try clicking on the various pages of information, Data Component, Index Component or Load Estimates.

7. Click on the Dasd Extents Tab to display the list of extents.
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This displays the detailed Index and Data component extent information for this VSAM file, by Volume in physical
sequence.

Click on the Show Extent Map button to display a visual map of the extents.
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Click on the Return button to return to the Extent List.

Click on the Return button to return to the chart after viewing any desired detail information.

8. Skip over one or more exceptional files for the next chart.
Charts are often made more useful by skipping over one or more few exceptionally large entries.

Click on the Right Arrow button to begin the chart with the second file from the current list.

The message area shows that the chart now begins with file 2.
Use the right and left arrow buttons to scroll the file list while adjusting the chart scale. You may also use the
scroll bar at the bottom of the chart to view the rest of the files.

Click on the Return button to return to chart selection.

9. Exit the application.
Click on the Exit menu option.
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VSAM Object Database Contents

The following data items are contained in the VSAM Object Databases created and used by the BIM-VSUM/PC Tools.
Each row in the database contains the information from one VSAM cluster, including both the Data Component and
Index Component, if one exists.

CATALOG_NAME - The name of the VSAM Catalog that contains the Cluster.

CLUSTER_NAME - The name of the VSAM Cluster.

CLUSTER_TYPE - The type of VSAM Cluster, for example a VSAM Key Sequence Dataset or KSDS will be
'INDEXED', a ESDS will be 'NONINDEXED'.

DATA_RECORDS - The count of data records from the Catalog statistics. This count may not be accurate and can be
shown as zero depending on the type of usage.

TOTAL_ALLOC_RBA - The total allocated DASD space for this file, it is the sum of the Data and Index
components.

TOTAL_USED_RBA -The total DASD space currently in use for this file, it is the sum of the Data and Index
components.

DEFINED_FREESPACE- The is the estimated amount of data space reserved for adding new records after initial file
creation based on the current CI Freespace and CA Freespace percentages. This only applies to VSAM Keyed
files.

TOTAL_EXTENTS - The total number of DASD extents, it is the sum of the Data and Index components.

TOTAL_EXCPS - The total number of physical I/Os or EXCPs for this file, it is the sum of the Data and Index
components.

DATA_ALLOC_RBA - The DASD space allocated to the Data Component of this file.

DATA_USED_RBA - The DASD space currently in use by the Data Component of this file.

DATA_EXTENTS - The number of DASD extents in the Data Component of this file.

DATA_FREESPACE- The DASD space that is allocated to the Data Component of this file but has not been utilized
to store any data.

INDEX_ALLOC_RBA -The DASD space allocated to the Index Component of this file.

INDEX_USED_RBA - The DASD space currently in use by the Index Component of this file.

INDEX_EXTENTS -The number of DASD extents in the Index Component of this file.

INDEX_FREESPACE -The DASD space that is allocated to the Index Component of this file but has not been
utilized to store Index records

TOTAL_REQUESTS- The total number of VSAM data accesses, including, records retrieved, updated, added, and
deleted from this VSAM file. ( Note 1)

DATA_RETRIEVED- The total number of data records retrieved from this VSAM file. ( Note 1)
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DATA_INSERTS - The total number of data records added to this VSAM file.  ( Note 1)

DATA_UPDATES -The total number of data records updated in this VSAM file.  ( Note 1)

DATA_DELETES - The total number of data records deleted from this VSAM file.  ( Note 1)

DATA_EXCPS - The total number of physical I/Os or EXCPs for the Data component.

INDEX_EXCPS - The total number of physical I/Os or EXCPs for the Index component.

DATA_CISIZE - The size of the Control Intervals in the Data component.

DATA_CASIZE - The number of Control Intervals in each Control Area in the Data component.

INDEX_CISIZE -The size of the Control Intervals in the Index component.

INDEX_CASIZE - The number of Control Intervals in each Control Area in the Index component.

CA_SPLITS - The total number of Control Area Splits in this VSAM file.  ( Note 1)

CI_SPLITS - The total number of Control Interval Splits in this VSAM file.  ( Note 1)

CA_FREE - The percentage of each Control Area reserved for inserting records in the Data component of this VSAM
file.

CI_FREE -The percentage of each Control Interval reserved for inserting records in the Data component of this
VSAM file.

AVG_LRECL - The average record length that was specified when the VSAM file was defined. (Often, this may not
reflect the actual average record length.)

MAX_LRECL - The maximum record length allowed in this VSAM file, as defined.

DATA_KEYLENGTH - The fixed length of the key data in each data record.

DATA_KEYPOSITION - The fixed position of the key data in each record, relative to zero.

INDEX_RECORDS - The count of Index records in the Index component of this file.

INDEX_LEVELS - The number of levels in the tree structure of the Index component.

CREATION_DATE - The date when the VSAM dataset was defined in the VSAM Catalog.

SYSTEM_DATE - The date when the VSAM dataset was last updated.

BUFFERSPACE - The minimum amount of VSAM buffer storage for this file, as defined.

SHAREOPTIONS - The VSAM dataset sharing option, as defined.

INDEX_IMBED - The VSAM option to 'imbed' index records in the data component, as defined.

INDEX_REPLICATE - The VSAM option to 'replicate' index records, one record per DASD track, for improved
Index access, as defined.

CLUSTER_REUSABLE - The VSAM option to 'reuse' of empty a VSAM file without deleting the dataset, as
defined.
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MULTI_VOLUME - An indicator that the Data Component resides on more than one DASD volume.

READ_ONLY - An indication that all activity to this dataset recording in the Catalog statistics has been read only, no
inserts, updates or deletes have been noted.

DATA_VOLUME - This primary or only DASD volume for the Data component.

DATA_DEVICE - The DASD device type for the Data component.

DATA_SPACE_TYPE - The unit of allocation, TRACKS, CYLINDERS.in the Data Component.

DATA_SPACE_PRI - The amount of DASD space in the first or primary allocation in the Data component for this
dataset.

DATA_SPACE_SEC - The amount of DASD space in each additional allocation in the Data component for this
dataset, as defined.

DATA_PHYREC_SIZE - The size of each physical DASD record in the Data component.

DATA_PHYREC_TRK - The number of physical DASD records per track in the Data component.

INDEX_VOLUME - This primary or only DASD volume for the Index component.

INDEX_DEVICE -The DASD device type for the Index component.

INDEX_SPACE_TYPE -The unit of allocation, TRACKS, CYLINDERS.. in the Index Component.
INDEX_SPACE_PRI -The amount of DASD space in the first or Primary allocation in the Index component for this

dataset.

INDEX_SPACE_SEC -The amount of DASD space in each additional allocation in the Index component for this
dataset, as defined.

INDEX_PHYREC_SIZE -The size of each physical DASD record in the Index component.

INDEX_PHYREC_TRK -The number of physical DASD records per track in the Index component.

DATA_LOW_CYL - The lowest DASD cylinder address on the primary DASD volume for Data.

DATA_LOW_TRK - The lowest DASD track address on the primary DASD volume for Data.

DATA_HIGH_CYL -The highest DASD cylinder address on the primary DASD volume for Data.

DATA_HIGH_TRK - The highest DASD track address on the primary DASD volume for Data.

INDEX_LOW_CYL -The lowest DASD cylinder address on the primary DASD volume for Index.

INDEX_LOW_TRK - The lowest DASD track address on the primary DASD volume for Index.

INDEX_HIGH_CYL - The highest DASD cylinder address on the primary DASD volume for Index

INDEX_HIGH_TRK - The highest DASD track address on the primary DASD volume for Index.

DATA_USED_PERCENT - The percentage of the allocated DASD space that is currently in use in the Data
component.  ( Note 1)
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READ_PERCENT - The percentage of all recorded accesses to this VSAM file which were read only.  ( Note 1)

INSERT_PERCENT - The percentage of the current number of records that have been added since the Dataset was
defined.  ( Note 1)

UPDATE_PERCENT - The percentage of the current number of records that have been updated since the Dataset was
defined.  ( Note 1)

DELETE_PERCENT -The percentage of the current number of records that have been deleted since the Dataset was
defined.  ( Note 1)

DATA_FRAGMENT - This is a calulated number of DASD Cylinders. It indicates that the Data component spans a
larger portion of the DASD volume than if all the extents were contiguous. This will not be calculated for
multivolume files.

INDEX_FRAGMENT -This is a calulated number of DASD Cylinders. It indicates that the Index component is
separated from the Data component, which may degrade performance due to added DASD movement. This
will not be calculated if the Index and Data are on different DASD volumes.

CI_SPLIT_PERCENT - The percentage of record insertions which caused CI splits.  ( Note 1).

CA_SPLIT_PERCENT -  The percentage of record insertions which caused CA splits.  ( Note 1).

STATS_DATE - The date taken from the VSAM LISTCAT indicates the date when the VSAM Catalog information
was captured.

Note 1 - There are a number of situations that cause the information and statistics in a VSAM Catalog to be missing or
inaccurate. These data items may still be useful but must be carefully examined to avoid incorrect analysis.
For example some Database products will use a VSAM dataset for storage without recording any records
retrieved in the statistics. The information here is taken directly from the VSAM Catalog and is therefore
subject to the same limitations.
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VSAM Dasd Extent Database Contents

The following data items are contained in the VSAM Dasd Extent Databases created and used by the BIM-VSUM/PC
tools. This Database is used to store the detailed extent information displayed in both text and graphical views.
This helps the VSAM Administrator see how fragmented the placement of the Index and Data portions are on
the Dasd volumes. This Database will use a prefix of VSEXT. The suffix will be set to match the VSAM
Object Database.

CATALOG_NAME - The name of the VSAM Catalog that contains the VSAM file extent.

CLUSTER_NAME – The VSAM Cluster that occupies the Data or Index extent.

EXTENT_TYPE  - This will be either ‘Data’ or ‘Index’ depending on the component.

EXTENT_NUMBER – The relative number of this extent.

EXTENT_VOLUME – The Dasd Volume ID of this extent.

LOW_CYL - The starting Cylinder address for this extent

LOW_TRK - The starting Track address for this extent

HIGH_CYL - The ending Cylinder address for this extent

HIGH_TRK  - The ending Track address for this extent

START_TRACK  - The relative starting Track address for this extent

TRACKS  - The number of Dasd Tracks for this extent

LOW_RBA  - The starting VSAM Relative Byte Address for this extent

HIGH_RBA - The ending VSAM Relative Byte Address for this extent
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VSAM Association Database Contents

The following data items are contained in the VSAM Association Databases created and used by the BIM-VSUM/PC
tools. This Database is used to store the names of the VSAM ‘objects’ related to a VSAM Cluster. This could
be the names of the Index and Data Components, or a VSAM Alternate Index or Path. This helps the VSAM
Administrator locate alternate indexes to plan for the effects of a Delete/Define. This Database will use a
prefix of VSASC. The suffix will be set to match the VSAM Object Database.

CATALOG_NAME - The name of the VSAM Catalog that contains the VSAM objects.

CLUSTER_NAME – The name of the VSAM Cluster or AIX.

ASSOC_NAME  - The name of the associated VSAM Object.

ASSOC_TYPE  - The type of the associated VSAM Object, which could be : ‘Cluster’, ‘Data’, ‘Index’ , ‘AIX’, or
‘Path’.
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VSAM Space Database Contents

The following data items are contained in the VSAM Space Databases created and used by the BIM-VSUM/PC Tools.
This Database is used to store the information about VSAM DASD Space owned by VSE/VSAM Catalogs and is used
to help analyze this information stored in VSE/VSAM Catalogs. Each row in the database contains the information
from one VSAM DASD Extent, resulting from a DEFINE SPACE command.

CATALOG_NAME - - The name of the VSAM Catalog that contains the defined DASD space.

SPACE_VOLUME – The disk volume identifier.

START_CYL – The beginning disk cylinder address.

START_TRK – The beginning disk track address.

DEVICE_TYPE – The disk device type, for example 3380 or 3390.

TRACKS_CYL – The number of tracks per cylinder for this disk type.

CYL_VOLUME – The total number of cylinders per volume for the disk volume.

ALLOC_TRK – The total number of tracks allocated for this VSAM Space entry.

USED_TRK – The number of tracks currently allocated to a VSAM dataset.

TRACK_CAPACITY – The maximum amount of data that could be stored on one track. This is used for comparing
one disk geometry to another. The actual amount of data per track will depend on the phyical block size for
each VSAM dataset.

TOTAL_ALLOC – The maximum amount of data that could be stored in this VSAM Space, based on the number of
tracks and the track capacity.

TOTAL_USED – The maximum amount of data that could be stored in the portion of  the VSAM Space which is
currently in use based on the number of used tracks and the track capacity.
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